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How to Save the Kronos URL as a Favorite or Bookmark

Internet Explorer

Saving the Kronos link as a favorite in Internet Explorer does not work automatically since it uses an
incorrect address. These instructions will show you how to reassign the URL address to the correct
location.

Click on URL:

https://kronos.dartmouth.edu

Click on Add to Favorites.

I

Favorites Feeds History

Add to favorites |«

Right click on the new saved Favorite link, select Properties.

& | Kronos - TIM

£ | Kronos - Erbium

a Kronos NEW PR

. Kronos Open

€| Kronos ZINC Open in New Tab

& | Kronos IRON Add to Favorites Bar
Create New Folder
Sort by Name
Print
Cut
Copy
Delete
Rename
Properties
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Web D i X X X ;
Type the URL address General eb Uocumen |Secur|t3r| Details | Previous Versmns‘
https://kronos.dartmouth.edu into N
. . | Kronos
the URL text box, then click Apply. LF’T]
-
JRL: https://kronos.dartmouth.edu K
Shortcut key: None
Wisits: Unknown
Change lcon...
0K ] ’ Cancel ] ’ Apply
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Firefox
Bookmarl Tools Help
|- Show All Bookmarks Ctrl+Shift+B h_try_count=08icont
Select Bookmarks on the top Menu. | Bookmark This Page Ctrl+D

Subscribe to This Page...

:H Bookmarks Toolbar L
168 Recently Bookmarked L
Click on Bookmark This Page. B Recent Tags ' N
| I Mozilla Firefox 4
| From Internet Explorer 4
Dartmouth Web Authentication

Right click on the new bookmark and select properties.

i Kronos
i Kronos7.0 Open

Open in a New Tab
Unsorted Bookmarks

Open in a New Window

TOor S oIT s page o

faculty, staff, and alum Mew Bookmark...

) Mew Folder...
Please log out and exit] s

New Separator
Cut
Copy

Paste

Delete

Propertjes

perti
Type the URL address Name: Kronos
httDs://k.ronos.dartmouth.ed.u into Location: https://kronos.dartmouth.edu
the Location text box, then click Save.
Tags: Separate tags with commas B
Keyword:
Description:
I [ Load this bookmark in the sidebar I
Save ‘ ‘ Cancel ‘
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Possible Problems When Logging into Kronos

[r—| MEW MEW  Mew new unine 1003y NEXT J Uay  WOrK  WeeK |MORNIN|>Cneaule
— -

Your Account is not Configured Properly @< oreoraman wmommenaseoeer B

- ‘é‘ https://kronos.dartmouth.edu/wfc/550/logonWithUID
— " " - - - o —

File Edit View Favorites Tools Help
< Favorites | 5 @] Suggested Sites = & Web Slice Gallery +

/& Kronos WORKFORCE CENTRAL(R)

Sometimes you may receive the error "Your Workforce Central venons

account is not configured properly."

Dartmouth

Then you will see the Web Authentication logged out screen.
Dartmouth Home | Search |

Dartmouth
Web Authentication

You have been logged out of the Dartmouth time system

For your security, please completely exit your web browser if you are finished accessing restricted applications. To exit, go to the File menu of your Web browser and choose Exit,
Close or Quit.

To log out of the Dartmouth Web Authentication system dick here. You must also dear vour Kerberos tickell® or remove your eTokenlH to clear any credentials that have been
temporarily stored on this computer.

One potential reason for this is that your favorite/bookmark is not configured properly. Please
follow the instructions starting on Page 2. You can also try copying and pasting the correct Kronos URL
into your browser: https://kronos.dartmouth.edu

If your favorite/bookmark is correct, the error can be KRONOS sTif]ﬁtuﬂ{'“ i
due to not logging out of Kronos correctly. To avoid
this error, you must click on Sign Out at the top left "*!’ff Self Service
hand corner of your screen. My Timecard  ~
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Java Errors

If your Java needs to be updated to the minimum version of 1.8.0_45 (recommended Java version is
1.8.0_92) then you will be prompted automatically to download that version when you first login to
Kronos.

If for some reason you accidentally uploaded a higher
version that does not work with Kronos or any of your
other systems, then you will need to remove Java and | \=| About Java
reload it by logging into Kronos again (see Uninstalling
Java section).

Programs (3)

= CDﬂf[ View Java version information.

|=:| Visit Java.com

To find out what version Java you are using: Control Panel (1)
1. Click on the Start Menu. - ]
2. Type “java” in the search box. |2 Java (32-bit)

3. Click on “About Java’. You should be on a
minimum of Java 1.8.0_45.

Start Menu ; See more results

‘ java|
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If you get the error shown on the below, try entering Compatibility Mode (see final section).

KRONOS

M Administration

Allen S Gable
Sign Out

L]

Setup > Scheduler Setup

You should add Kronos to the
Exception Site List.

Do this by selecting the security tab

on the Java control panel (to find the
panel, see instructions above).

\

Click on Edit Site List.

| £ Java Control Panel '

| General | Update | Javal Security | Advanced

| Enable Java content in the browser

Security Level

Very High

[C_» High {minimum recommended)

Medium

Java applications identified by a certificate from a trusted authority will be allowed to run.

Applications launche
security prompts.

https: /fkronos. dartmouth. edu/

sites listed below will be allowed to run after the appropriate

il | Edit Site List. .. |
Restore Security Prompts | | Manage Certificates.. |
[ oK ] | Cancel App




Click on Add and type in this
location:

https://kronos.dartmouth.edu/

Click on OK.

Dartmouth College Technical Support Document for Kronos

W& Exception Site List - E—— <l

Applications launched from the sites listed below will be allowed to run after the appropriate security
prompts.

Lecation

-|1:I:|:|s:,’,.'Icl'::um:us.|:‘Jar1:|11c:|L.|1:i'1.er:‘]u,r |

[ Add H Remove ]

L"Ih FILE and HTTP protocols are considered a security risk,
We recommend using HTTPS sites where available.
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Clearing the Java Temporary Internet files can help resolve Java issues. This option is located in the
Java Control Panel on the General tab. Click on Settings, click on Delete Files, and then make sure
the boxes for “Applications and Applets” and “Trace and Log Files” are checked, then click OK.

: =T
General | Update | Java | Security | Advanced
i About
View version information about Java Control Panel.

i Network Settings

Network settings are used when making Internet connections. By default, Java
will use the network settings in your web browser. Only advanced users should
modify these settings.

Network Settings... |

i Temporary Internet Files

Files you use in Java applications are stored in a spedial folder for quick exed
later. Only advanced users should delete files or modify these setting

| = ]
Keep temporary files on my computer.
Location
Select the location where temporary files are kept:
lsers\fOO 1dy0\AppData\LocalLow\Sun\Java\Deployment\cache [ | Change... |
Disk Space
Select the compression level for JAR files: None -
amount of disk space for storing temporary files:
L ool M8 |
i
| DeleteFies.. | | RestoreDefauts |
[ ok || cancel | -

You will also need to delete your browsing history.

If you are using Internet Explorer, this is located under the Tools menu.
For Firefox, it is located under the History menu.
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Uninstalling Java

If you have downloaded a higher version of Java that is not working with Kronos follow these steps
to uninstall that version. BXCFiles 0N STuckiThay TS

|©] Microsoft Outlook 2010
(¥] Microsoft Excel 2010

[E, Microsoft OneNote 2010
(W] Microsoft Word 2010

@ Morzilla Firefox

& Internet Explorer

"% Snipping Tool

Megan E. Tompkins
Documents
Pictures

Music

Go to the Control Panel:

Computer

Control Panel

Help and Support

» All Programs Run...

Shut doan FShutdown | > |

Click on Programs and Features:

.. . = @ v Control Panel » All Control Panel ltems » - Search Control P yel |

Adjust your computer’s settings

P Action Center
qu BitLocker Drive Encryption
@ Default Programs

E_Q Devices and Printers
Folder Options

@ iCloud

Internet Options

B Mail (32-bit)

Programs and Features
Em Esktop Connections
B Systern

a Windows CardSpace

L Windows Update

Administrative Tools
Kl Color Management
& Dell Touchpad

= Display

| Fonts

IDT Audio Centrol Panel
@I Java (32-bit)

F Mouse

“,:l Personalization

@G QuickTime (32-bit)

% Sound
_l Taskbar and Start Menu
i Windows Defender

[mg AutoPlay

Credential Manager
[#% Desktop Gadgets

@ Ease of Access Center
=l Getting Started

ﬁ‘ Indexing Optiens

&2 Keyboard

5% Network and Sharing Center
U;J Phone and Modem
é‘l‘ Recovery

é Speech Recognition
Troubleshooting

& Windows Firewall

@ Backup and Restore

j' Date and Time

&2 Device Manager

Flash Player (32-bit)

@ HomeGroup

w Intel(R) Graphics and Media
Location and Other Sensors
3 Notification Area Icons

3 Power Options

& Region and Language

@ Sync Center

% User Accounts

B Windows Mahility Center
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Find the Java version you wish to uninstall and right click. Select Uninstall.

o 5

F e e b e e b e e = Search Programs and Features o

Control Panel Home

Uninstall or change a program

View installed updates To uninstall a program, select it fram the list and then click Uninstall, Change, or Repair.
'@ Turn Windows features on or
aif Organize *  Uninstall d== - @
Install a program from the =
netwark Mame Publisher Installed On  Size Version o
ﬁﬁ\pple Application Support AppleInc. 1/23/2014 943MB 30
: Apple Mobile Device Support AppleInc, 1/23/2014 227MB 71032
@Apple Software Update Applelnc, 8/4/2011 238MB 213127 F
& Bonjour Applelnc 11/9/2011 200MB 30010
@ Citrix online plug-in Citrix Systems, Inc. 17472013 121441
& Dell Touchpad ALPS ELECTRIC CO., LTD. 1/4/2013 71211101114
ﬁlDisableJava Updates Dartmouth College 8/2/2013 617 KB 1.00.0000 g
B8 Driver Tool Driver Tool 8/22/2013 996 MB 81
iCloud Applelnc. 1/16/2014 156 MB  31.0.40
4 Intel® HD Graphics Driver Intel Corporation 8/7/2013 742MB 91710.2932
# iTunes AppleInc, 1/23/2014 215MB 111462
[[£])ava 7 Update 21 T uea b 2/3/2014 130ME  7.0.210
2] Java(TM) 6 Update 27 N o N | 1/2/2014 970MB 60270
| £{Java(TM) 6 Update 29 Oracle 9/4/2013 970MB  60.290
:l%]uniper Networks Network Connect 7.1.0 Juniper Networks 1/4/2013 71.019525
:l%]umper Metworks Network Connect 71.10 Juniper Networks 1/4/2013 71.10.21187
:i%]uniper Metworks Metwork Connect 71,11 Juniper Metworks 1/4/2013 7.1.11.21451
:%Juniper Networks Network Connect 7.2.0 Juniper Networks 2/20/2013 7.2.0.22399
:l%]uniper Networks Network Connect 7.3.0 Juniper Networks 9/6/2013 7.3.0.26561
[=°T Juniper Metworks, Inc. Setup Client Juniper Metworks, Inc, 9/6/2013 800KB 7.3.7.38707
[ Juniper Metworks, Inc. Setup Client 64-bit Activex Co...  Juniper Networks, Inc. 2/20/2013 2111 il
e VN S S S, e
(( Oracle Product version: 7.0. Support link: http://java.com Size: 130 MB
E Help link: http://java.com Update information: http://java.sun.com

Login to Kronos again and you will be prompted to install the minimum version of Java 7.55.

Keeping Multiple Versions of Java

This is how you can keep multiple versions but disable some of them (sometimes Java does not keep the

older versions but writes over them:

|£| Java Control Panel = = |

‘ General I Update‘ Java ‘ Security | Advanced

View and manage Java Runtime versions and settings for Java applications and applets.

View.
Lﬁi]ava Runtime Environment Settings ‘ = ‘
[
User | system
Platform Product Location Path Runtime Parameters Enabled
1.8 1.8.0_101 http:/fiava.sun.com/produ... |C:\Program Files (x86)\Javaljre1.8....
1.8 1.8.0_45 http:/fiava.sun.com/produ... |C:\Program Files (x86)\Java'ijre1.8.... =
1.7 1,7.0_75 http:/fiava.sun.comfprodu... [C:\Program Files (x86)Java'jre7\bi... =

11
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Blank Screen

Some users can login to Kronos, but once there only see a blank screen.
If this happens to you, try the following steps.

Internet Explorer - HTML5

Most of the screens in Kronos 8 are now rendered using HTMLS5 instead of Java that was used in previous versions of
Kronos. If some of the screens that you try to access are blank, you will need to make one or both of the following
changes:

1. From Internet Explorer select the Tools Menu and select Internet Options.

e Sl @ https://kronos.dartmouth.edu/wfc/applications/naviga O ~ @ & || & Kronos WORKFORCE CENT...

File Edit View anta;gmm
s i FS - D Ctrl+Shift+Del

=l

| Oracle Help elete browsing history...

t~ | Library Resources =

InPrivate Browsing Ctrl+Shift+P
Enterprise Mede
Turn on Tracking Protection

ActiveX Filtering

# Administration Fix connection problems...

My Genies Reopen last browsing session

DC Recancile Timecard = G R ST

View downloads Ctrl+)
ik ¥
El x 1+ Pop-up Blocker 3
Seecthl  Comn A SmartScreen Filter v
Manage add-ons
Mame Early Out Late Out
Compatibility View settings
A T
Subscribe to this feed...
. c Feed discovery »
A h Windows Update
A n
Performance dashboard Ctrl+Shift+U

F12 Developer Tools

OneNote Linked Notes
Skype for Business Click to Call
Send to OneNete

Report website problems
o > I Intemet options I

2. Click on the Security tab, select the Trusted sites security zone, and click the [_sts | puytton.

Internet Options D
seaurity | privacy | Content | Connections [ Programs | Advanced |

Select a zone to view or ch ity sett
‘ ) 4
q - v
Internet  Localintranet] [EFETS] | Restricted
sites

Trusted sites —
7 This zone contains websites that you | [ s ] I

V' trustnot to damage your computer o
Your fies.
You have websites in this zone.

Security level for this zone

‘Custom
Custom settings.
~To change the settings, click Custom level,
~To use the recommended settings, click Defauit level.

[T Enable Brotected Mode (requires restarting Internet Explorer)

gusto level... Defaultlevel
Reset al zones to default level

3. Make sure that https://kronos.dartmouth.edu or https://*.dartmouth.edu are NOT included in the list of
websites.
12
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Trusted sites

- ==

v 4 this zone will use the zone's security settings.

Add this website to the zone:

Websites:

gateway.dartmouth.edu
http:/fsharepoint.dartmouth.edu
https:/fapex.orade.com

m| »

[¥] Require server verification {https:) for all sites in this zone

# ‘'fou can add and remove websites from this zone. All websites in

Close

4. Toremove a website from the Trusted sites Security Zone, select it in the list and click ([ Remore ]

Trusted sites . it

# You can add and remove websites from this zone. All websites in

/' this zane wil use the zone's securty settings.

Add this website to the zone:

Websites:

https://sharepaint. dartmouth.edu
https: fvirginpulse. yonyx. cam

Require server verification (https:) for all sites in this zone

Close

hicpsfepm cartmoth e -
https: /fkronos. dartmouth.edu

5. If you have removed one or more URLs from the list of websites, click Close and then OK.

6. Close the browser and reopen. After opening Kronos the screens that were blank should now be visible. If not,

go onto the next step.

7. From Internet Explorer select the Tools Menu and select Compatibility View Settings.

e ol @ https://kronos.dartmouth.edu/wic/applications/navige © ~ @ & H (& Kronos WORKFORCE CENT...

File Edit View Favorites ﬂHE\p
CtrbeShife+Del

% U FAs

A Administration

My Genies

DC Reconcile Timecard »

Oracle Help Delete browsing history...

InPrivate Browsing Ctrl Shift+P
Enterprise Mode

Tumn on Tracking Protection

ActiveX Filtering

Fix connection problems...

Reopen last browsing session

Add site to Start menu

View downloads Ctrl+)
<

Pop-up Blocker 3
Al SrmartScreen Filter »

Manage add-ons

Compatibility View settings
T
Subscribe to this feed...
c
Feed discovery 5
Windows Update
Performance dashboard Ctrl+Shift+U

F12 Developer Tools

OneNote Linked Notes
Skype for Business Click to Call
Send to OneNote

Report website problems

Internet options

t v

Library Resources =

EarlyOut  Late Out

8. Make sure that kronos.dartmouth.edu is not included in the list of websites for Compatibility View and that the

“Display intranet sites in Compatibility View” is NOT selected.

13
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Compatibility View Settings =

[y Change Compatiiity View Settngs
(A

Add this website:
[ Add

Websites you've added to Compatibilty View:

Remove

[ | Display intranet sites in Compatibility View
Use Microsoft compatiilty lists

Learn more by reading the Internet Explorer privacy statement

9. If you have removed one or more URLs from the list of websites, click Close and then OK.
10. Close the browser and reopen. After opening Kronos the screens that were blank should now be visible. If not
please contact Kronos.Admin@dartmouth.edu.

Internet Explorer - Java Issues
Java is not required for Student and Bi-Weekly Employee

| £/ Java Control Panel

‘ General I Update | Java I security || Advanced

users, but approvers, finance centers and payroll users may

Debugging A
i--[7] Enable tracing
+++[F] Enable logging
[ show applet lifecycle exceptions
Java console
i@ Show console

still encounter this issue.

1. From the Start Menu click Control Panel
2. Click Java (32-bit)
3. On the java control panel click the advanced

m

7 Hide console

7 Do not start console
Default Java for browsers
Microsoft Internet Explorer
-[¥] Mazilla family
Java Plug-n

tab -[¥] Enable the next-generation Java Plug-in (requires browser restart) M
. Shortcut Creation
4. Under Java Console enable the radio button © Aways alon

(") Always allow if hinted

~) Prompt user

(@) Prompt user if hinted
() Never allow

INLF FileMIME Assodiation

7)) Abways allow

(@) Prompt user
) Never allow

Application Installation

~-@ Install if hinted

--(_) Install if shortout created
() Installif hinted and shortout S

next to Show Console

14
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5. Start Internet Exporer and log into Kronos. Lo v Comsole i | e
: ¢ hid | .
6. Once the Java Console comes up, click - febad polcy coniguraton
. . non s: dump system and deployment properties
anywhere in the window and type "x". I t: dump threadiist
" " v: dump thread stack
Clear classloader cache...completed x: _dear dassloader cache
0-5: set trace level to <n>

should be displayed il

Initializing VM for plug-in
JVM loading complete
Calling javascript function: eval |
Adding listener: superSummary.applethame - com.kronos.wfc. commonapp.genies.applet.man
Debug mode: false

###ThemedResources.loadTheme() loading theme from JAR
###ThemedResources.loadThemeFromJar() getting theme from : jthemes/basic/theme.css
Request made for a theme value with an invalid selector

Total 6 WTK Group Edit extension(s) found.

Sending GET request - URL: https:/fkronos. dartmouth. edu/wic/summarycolconfigserviet?view
Setting Cookie For The Connection: JSESSIONID=VFOMvEngaVhn33+1ixyAkOmS; _ utma=25
Sending GET reguest - URL: https:/fkronos. dartmouth. edujwfc/summarydataserviet?viewld=
Setting Cookie For The Connection: JSESSIONID=VFOMvEngaVhn33+1ixyAkOomS; _ utma=25
Clear dassloader cache ... completed. | 4

m

[ Clear ]

15



Firefox

4. Under time range to clear select Everything
5. Make sure Cache and Offline Website Data are

Open Firefox and click the three line menu icon

in the upper right
Select options from the menu then click
Privacy along the top

Under Privacy click the link for clear your
recent history

checked and then click Clear Now

Chrome

B W N e
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= — r T
frsl= E = e 1
General Tabs Content  Applications ~ Privacy curity Sync

[[1Ed
‘ x|

Advanced

Tracking

() Tell sites thatI do not want to be tracked

(7) Tell sites that I want to be tracked

@ Do not tell sites anything about my tracking preferences

Learn More

History

Firefox will: | Remember history -

|
refox will remember your browsing, download, form and search history, and |I
kies from websites you visit.
l
You may want to clear your recent history, or remove individual cookies. I
|
U
Location Bar
‘When using the location bar, suggest: | History and Bookmarks =
[ QK l ’ Cancel ] ’ Help ] :l
-
Clear All History l&]i
Time range to clear: [Everything 'l
All selected iterns will be cleared.
A L This action cannot be undone,
l |
Details
|
[] Browsing & Download History
[] Form & Search History
[[] Cookies
ll Cache
[] Active Logins
Offline Website Data
[7] Site Preferences
[ Clear Now l l Cancel l J
LS

Open Chrome and click the three line menu icon in the upper right.

Select settings from the menu then click Show Advanced Settings... at the bottom.

Under Privacy click the Clear Browsing Data... button.

Under ‘Clear browsing data,” make sure everything is unchecked except Cached images and

files and Hosted app data.
Click the Clear browsing data button.

16
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System Requirements

Browsers:

Internet Explorer 11
Google Chrome 41+
Mozilla Firefox 35+
Apple Safari 7.x

Operating Systems:
Windows 10

Windows 8 and 8.1 (64-Bit)
Windows 7 (32 & 64-Bit)
Macintosh 0SX 10.9 and 10.10

Other Software:

Adobe Flash Player - whatever the latest version that is supported by the browser
Java 1.8.0_45 - minimum, 1.8.0_92 - recommended (Java is not required for Student and Bi-Weekly
Employee users)

NOTE: This software is not optimized for use on any mobile devices (iPhone, iPad, etc.)

17



